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Disclaimers and Legal Information 
Copyright © 2020 Aimetis Inc. All rights reserved. 

This material is for informational purposes only. AIMETIS MAKES NO WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, AS TO 
THE INFORMATION IN THIS DOCUMENT. 

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no 
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any 
means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written 
permission of Aimetis Corp. 

Aimetis may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject 
matter in this document. Except as expressly provided in any written license agreement from Aimetis, the furnishing of this 
document does not give you any license to these patents, trademarks, copyrights, or other intellectual property. 

Aimetis and Aimetis Symphony are either registered trademarks or trademarks of Aimetis Corp. in the United States and/or 
other countries. 
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Document History 
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May 2013 Release 6.11.1 
April 2013 Release 6.11.0.1 
March 2013 Release 6.11 
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Release 6.11.4.7 

Symphony Fixed 
Fixed 
AIR-42837 The Symphony Client connects to the Symphony Server as expected after 

applying the cumulative update for .NET (KB4565627 or KB4565633) from 
Microsoft. 

Release 6.11.4.5 
Contains Device Pack 1.0.21.4 

Device Pack Fixed 
Fixed 
PACK-1833 Erroneous dialog box with SurrogateExe.exe no longer displayed 
PACK-1836 Bosch: Correct FPS settings used and displayed  

 

Symphony Fixed 
Fixed 
AIR-18565 Erroneous setting and message to delete Axis video encoder from farm resolved 
AIR-24167 Switching cameras in Web Client working correctly 
AIR-24169 Web Client login working correctly 
AIR-24246 Detailed Events correctly logging configuration change 
AIR-24271 Web Client alarm list correctly displays images 
AIR-24428 Switch views on alarm working correctly 
AIR-24689 Manage Security permissions working correctly based on user configuration 
AIR-24768 Panel switching of video wall successful 
AIR-24769 Client option setting Perform action after switch successfully disabled 

 

Release 6.11.4.3 
Contains Device Pack 1.0.21.0 

New 
New 
AIR-14810 Importing devices with multiple streams via CSV file now supported 
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Improvements 
Improvements 
AIR-11562 Tools available include correct version numbers, including: 

• VideoWallAlarmSwitchConfig 
• AddDIORulesFromCSV 
• SetActiveProfile 

AIR-22266 Video decoration font improvements implemented 

Fixed 
Fixed 
AIR-13952 Second stream video displaying correctly 
AIR-18339 You can now hide the mouse cursor on live video displaying on any video panel. 

When this feature is enabled, the mouse cursor disappears after five (5) seconds 
of mouse inactivity. The cursor reappears immediately when the mouse moves or 
when an alarm popup appears in the system tray. 
 
This feature is disabled by default. To enable the feature per server, edit 
%appdata%\<ProductFolder>\acc.ini  and change the following parameter as 
needed: 
[CameraVideoView]  
CursorOffOnVideo=True 
 
Note: When an Alarm popup appears in the system tray, the cursor disappears 
five (5) seconds later until another alarm is detected. 

AIR-18878 Creating a New Camera View from an existing camera group working correctly 
AIR-19175 Resizing a New Camera View displaying correctly 
AIR-19707 Device Tree Configuration Cancel option working correctly 
AIR-22261 Device List correctly populated following server upgrade 
AIR-22265 Server Farm List correctly populated following server upgrade 
AIR-22269 Alarm popup window active and working correctly following server upgrade 
AIR-22271 Server Configuration dialog Server field displays the hostname of the server 

where the device is connected 
AIR-22274 Decoration color settings propagated throughout all servers in the server farm 

correctly 
AIR-22280 Changing video decoration transparency working correctly 
AIR-22305 Disabled PTZ notifications include usernames which are visible only to users with 

administrative privileges 
AIR-22320 Phoenix: Input mapping corrections implemented to prevent missing and 

duplicate input triggers 
AIR-22361 SDK: Panel switching working correctly 
AIR-22368 When attempting to switch panels using the SDK to unregistered clients, a 

notification error is displayed 
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Fixed 
AIR-22375 Licensing working correctly in large multi-server farms where servers have 

multiple MAC addresses and network interface controllers 
AIR-22399 Client no longer closing erroneously after managing Symphony services (Server > 

Services > Manage Symphony Services) 
AIR-22400 Web Client: Server connection performance and logging enhancements 

implemented 
AIR-22401 Video recording stops correctly when an alarm is triggered for a camera set to 

never record with a post-event buffer; recording stops when the entire post-
event buffer is complete 

AIR-22416 Videowall: Working correctly when loading new device model 
AIR-22417 Videowall: Mixed mode working correctly where server version is different than 

client version 
AIR-22418 Speed improvements implemented when switching live video via direct 

connection  
AIR-22422 When importing a PTZ camera as a fixed camera, editing the camera’s device 

configuration overwrites the camera type correctly 
AIR-22437 Camera tree updating immediately following device model changes. 

New devices added show with ID of 0 until the server updates with the correct 
camera ID 

AIR-22438 Maps: Client connection status visible in Maps panel  
AIR-22445 
AIR-22973 

Timeline: Purple circle indicating the current video panel position displaying 
correctly 

AIR-22450 Restricted users can view live video when the database is unavailable 
AIR-22453 On slow networks or hardware, intermittent dropped video data and playback 

issues resolved 
AIR-22466 Videowall: In a multi-server farm environment, concurrent panel switch 

commands working correctly 
AIR-22469 When a connection is lost, or a camera moves to a different server, client 

reconnects to historical video stream correctly 
AIR-22498 Moving digital I/O devices to another server signaled correctly via SNMP 
AIR-22796 Device model changes applied correctly when the Server Configuration dialog is 

open 
AIR-22943 Multiple login deny user permission working correctly 
AIR-22972 Setup Wizard working correctly in silent mode 
AIR-22981 Viewing blank camera working correctly 
AIR-22985 
AIR-23018 
AIR-23019 
AIR-23052 
AIR-23062 

Videowall: No longer logging erroneous errors when switching panels 

AIR-22986 Symphony Manager services working correctly for users with Administration 
privileges 
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Fixed 
AIR-22987 Web Client: Banning and unbanning video no longer causes camera tree display 

issues 
AIR-22994 Help > Report an Issue > Upload to Aimetis option saves file to desktop correctly 
AIR-22998 Video export working correctly 
AIR-23003 Users Viewing Camera option refreshing correctly when logged in user changed 
AIR-23005 Videowall: Client interface no longer hanging when Videowall Manager launched 
AIR-23006 Web Client: Server popup messages display and refresh correctly showing a 

maximum of 3 messages at any time 
AIR-23007 Device Tree configuration Apply option no longer resulting in Client crash  
AIR-23015 Videowall: No longer logging erroneous “Failed to connect to videowall 

controller” error during load balancing 
AIR-23016 Web Client: Timeline hidden after banning device 
AIR-23017 Videowall: Performance improvements implemented 
AIR-23021 Videowall: Decoration transparency settings pushed correctly to all viewers  
AIR-23023 Switch view when an alarm occurs functionality working correctly without 

logging erroneous exceptions 
AIR-23036 Videowall: Changing panel video quality working correctly via Videowall Manager 
AIR-23037 Server Configuration > General Settings > Decoration Text Background color 

preview displays the color name for Black and White and specific RGB values for 
any other specified color 
Note: Color preview does not include any configured Transparency value 

AIR-23055 Videowall: Clicking Refresh in Videowall Manager working correctly 
AIR-23069 Direct Connect devices displaying decorations correctly 
AIR-23072 Viewing camera activity (View > Activity for Cameras) and zooming in on images 

working correctly 
AIR-23079 View Current Logins functionality (Server > View Logins > Current Logins) displays 

computer hostnames only and not IP addresses 
AIR-23089 Modifications to Messenger message text size and position are correctly applied 

and updated 
AIR-23090 Digital I/O rules import and export via CSV loading policies and rules correctly 
AIR-23095 Client lock Panel add/Panel close functionality working correctly 

View > Settings > Lock > Panel adding/closing hides related menu buttons and 
their associated View menu options 

AIR-23096 Client interface unlock functionality no longer displaying erroneous permission 
error 

AIR-23989 Videowall: Video displaying on all panels correctly 

 
Release 6.11.3.3 
Contains Device Pack 1.0.14.0 
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New 
New 
AIR-16085 Auto-upgrade feature for Symphony client 

Improvements 
Improvements 
AIR-19610 Device Pack update can be postponed successfully when importing cameras 

through CSV file 
AIR-19662 Improved performance 
AIR-20027 Improved CPU performance and decreased memory impact 
AIR-20193 Reduced memory usage when device model refreshes 

Fixed 
Fixed 
AIR-19427 Web Client: Functions correctly and no longer displaying “Error getting remote 

version”  
AIR-19520 Symphony ensures disk cleaned before reaching full capacity 
AIR-19525 Infoservice continues working successfully after PollForChanges 
AIR-19528 User can successfully view historical images for a specific time 
AIR-19529 Farm name and logged in username correctly displayed in title bar  
AIR-19535 Web Client: Changing camera views working correctly and no longer sending 

PageRequestManagerParserErrorException or “Error communicating with server” 
warning 

AIR-19556 Digital input states correctly updated in Camera Tree 
AIR-19593 Setup Wizard correctly times out in case where server is not responding 
AIR-19594 Trackers correctly start with different server versions after swap while upgrading 
AIR-19596 Mixed mode, videowall switching successful 
AIR-19598 Cameras can be moved successfully without server license issue 
AIR-19602 Client works correctly with Alarm Log showing 1000+ alarms 
AIR-19603 Focus on selected camera in Camera Tree maintained correctly after Camera 

Tree refresh 
AIR-19604 SDK application: Resume Record Mode working correctly in live stream sample 
AIR-19606 Client CPU usage impact reduced sufficiently when large Camera Tree set to auto 

expand 
AIR-19607 Client sessions working correctly and no longer registering InvalidSession error 
AIR-19608 SDK application: Invoking Can Change Panel Videowall correctly shows 

permission error when invalid user entered 
AIR-19611 Editing user groups working correctly when device model changes  
AIR-19612 Server license correctly published on startup  
AIR-19620 Camera Tour: User successfully able to add first preset location 
AIR-19623 Active user profile access working correctly 
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Fixed 
AIR-19625 Database connection working correctly with no lost frames 
AIR-19627 Client runs successfully after interaction with Maps 
AIR-19628 16-panel multi-view closes successfully in expected time 
AIR-19631 Web Client: Runs successfully when InfoService down or not responding 
AIR-19633 Client auto upgrade successful 
AIR-19637 Request User Credentials working correctly 
AIR-19642 Users viewing camera correctly displayed in Map context menu 
AIR-19644 Users viewing camera feature correctly displays only users with live view 
AIR-19646 Videowall: Connection intact when creating 9 panel or larger multi-view  
AIR-19648 Videowall: Can successfully modify panel settings 
AIR-19649 Text displayed correctly in German 
AIR-19671 Tracker no longer producing Algolist.txt files. Following an upgrade, users can 

delete *agolist.txt from the Symphony data path to remove remaining legacy files 
AIR-19673 InfoService memory leak resolved 
AIR-19678 Server Registration with SSO working correctly 
AIR-19686 
AIR-19687 

Client auto-upgrade installation reruns automatically if Error Code 1618 reported 

AIR-19692 Client device model updates working correctly 
AIR-19696 Client auto-upgrade retains previous settings and configuration correctly 
AIR-19697 Web Client: Working correctly following server farm redirect 
AIR-19704 Users viewing Cameras displays correct information 
AIR-19705 Recording schedule changes saving correctly 
AIR-19706 Videowall: Layouts list sorted alphabetically 
AIR-19708 Device Tree Configuration: Can successfully add groups as administrator 
AIR-19710 
AIR-20896 

Client initializing correctly 

AIR-19716 Device name changes correctly 
AIR-19717 Clicking on an alarm successfully selects it 
AIR-19722 Poll rate changes saving correctly 
AIR-19723 View Detailed Events works as expected 
AIR-19727 PTZ Locked: Video decorations update correctly  
AIR-19728 PTZ Locked: Properties unlock correctly 
AIR-19729 PTZ Navigation buttons consistently notify user when control attempts are 

unsuccessful 
AIR-19736 Client interface remains visible while editing user groups 
AIR-19740 Alarm Log in advanced mode no longer causes a crash 
AIR-19745 Device Tree Editor loads successfully 
AIR-19748 Videowall SDK: Can view blank camera successfully in SymphonyFarmTest sample 
AIR-19749 Web Client: Timeline interface displays as expected 
AIR-19759 Camera Tree: Manually entered device states reflected correctly 
AIR-19894 Camera Tour: Location added successfully 
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Fixed 
AIR-19901 PTZ Indefinite Lock functions as expected 
AIR-19905 MessageDispatcher recovers successfully if no dispatchers available 
AIR-19953 Videowall panel switching works correctly, and better error reporting has been 

added.  
AIR-19959 Camera Tour: Deleting a tour works correctly 
AIR-19966 Camera Tour: Adding another tour works correctly 
AIR-19994 Xnet password no longer visible or logged 
AIR-20051 Videowall showing video correctly 
AIR-20095 Clients initializing correctly on startup 
AIR-20096 Client initialization delay resolved 
AIR-20098 Improved performance for trackers showing video 
AIR-20100 MJPEG cameras showing correct colors in images 
AIR-20148 Diagnostic Stats logging frequency changed from every four (4) seconds to once 

every five (5) minutes 
AIR-20184 
AIR-20194 
AIR-20195 
AIR-20196 
AIR-20221 
AIR-20224 
AIR-20247 
AIR-20253 

Improvements made to diagnostic error logging 

AIR-20190 Videowall: Error handling is improved is constantly crashing on the Videowall 
AIR-20233 Symphony Clients function correctly following a server farm upgrade 
AIR-20237 Johnson Controls: Device Discovery working correctly 
AIR-20256 Switching to 'Blank camera' works correctly 
AIR-20259 Event logs are captured successfully except during system archive.  

See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10278 
AIR-20263 Improvements made to server farm communications and error handling 
AIR-20269 Changing cameras works correctly 
AIR-20277 Images exported to a file or to the Windows Clipboard render with correct colors 
AIR-20281 Client authorization intact after switching security profile 
AIR-20284 Modifying Symphony Rules works correctly 
AIR-20299 Reason field correctly functioning as optional for Supervisor login after changing 

settings 
AIR-20304 Timeline in sync displaying JPG images 
AIR-20308 Web Client: Displays video correctly when prompting for install plugin 
AIR-20343 Client working correctly after importing devices 
AIR-20346 Improved performance moving multiple cameras between systems 
AIR-20350 Improved error handling and messages when hardware devices not found 
AIR-20351 Device Manager: Refresh working correctly 
AIR-20363 Client working correctly after switching cameras 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10278
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Fixed 
AIR-20364 Camera name and frame statistics correctly display on video 
AIR-20366 Client working correctly when trying to unlock PTZ during tracker restart or stop 
AIR-20408 PTZ locking working correctly 
AIR-20417 Symphony Client successfully saves device changes to an available server when 

the original server is unavailable 
AIR-20425 You can successfully configure PTZ on Q7406 encoder after an upgrade 
AIR-20429 Web Client: Load balancing correctly 
AIR-20430 Large camera import correctly includes all cameras 
AIR-20431 License updated correctly after adding camera 
AIR-20434 Direct-mode camera correctly displays access denied message when live video is 

denied or banned 
AIR-20435 Devices are correctly managed during a server failover 
AIR-20438 Alarms are no longer visible in the Client, Alarm Logs, and via alarm popups for 

cameras with banned video 
AIR-20440 Camera imports work correctly 
AIR-20441 Changes to device groups are saved and displayed correctly across multiple 

Symphony Client instances  
AIR-20443 Active directory user resolution works correctly via Single Sign-On 

See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10279 
AIR-20446 System messages correctly displayed when client restarted 
AIR-20447 PTZ lock priority messages improved 
AIR-20448 Setup Wizard works correctly during InfoService interruptions 
AIR-20450 Client continuous working correctly when loading Device Tree 
AIR-20452 Clients working correctly following Videowall Manager modifications and refresh 
AIR-20455 Client no longer displaying erroneous pop-up message “Attempt to release mutex 

that was not owned by caller” 
AIR-20456 Videowall Controller panels connecting correctly 
AIR-20457 Timeline working correctly for missed signals and disk full scenarios 
AIR-20458 Messaging improved when unauthorized users attempt to control PTZ cameras 
AIR-20461 Symphony database connection regained correctly following disconnection 
AIR-20464 Exporting cameras to CSV file works correctly 
AIR-20465 User changes are saved successfully  
AIR-20466 Device Pack: Installer warns you that it requires all Symphony services stopped 

before installation begins 
AIR-20467 User Permissions dialog  displays correctly 
AIR-20468 Backup configuration restore working correctly 
AIR-20469 Alarms working correctly regardless of database connectivity 
AIR-20470 Device model changes are pushed correctly to database on refresh 
AIR-20481 Camera import from CSV works correctly 
AIR-20568 PTZ Lock Message no longer erroneously displayed on client 
AIR-20600 Symphony installer prevents upgrade to an unlicensed version 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10279
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Fixed 
AIR-20606 PTZ camera logs captured correctly 
AIR-20626 Camera initialization working correctly 
AIR-20654 InfoService logging active user data correctly  
AIR-20669 Symphony Installation includes required 64-bit runtime files for 64-bit OS systems 
AIR-20692 Alarm Log scrolls to focused row when new alarm occurs 
AIR-20754 Database up/down state moved to Shared Memory 
AIR-20783 Alarm Logs working correctly 
AIR-20791 Direct Connect working correctly 
AIR-20794 Tracker works correctly showing video when database is down 
AIR-20841 VE180 configuration retained after upgrade 
AIR-20844 Discovering devices works correctly 
AIR-20846 Client working correctly during periods of high CPU usage 
AIR-20862 Rule Wizard working correctly 
AIR-20471 
AIR-20873 
AIR-20897 
AIR-20898 
AIR-20935 
AIR-20936 

Videowall: Panel switching working correctly  

AIR-20876 Scheduler automatically restarts after Phoenix device goes offline 
AIR-20890 Rule Wizard: Schedule edits working correctly 
AIR-20899 Client software updates automatically 
AIR-20905 Switch view on alarm working correctly 
AIR-20908 PTZ Lock Message no longer erroneously displayed on client 
AIR-20915 Videowall: Camera switching working correctly 
AIR-20916 Web Client: Displaying Profile Switch messages correctly 
AIR-20933 The View Blank Camera option works correctly when viewing JPEGs 
AIR-21640 Axiom RBH Access Control working correctly 

Release 6.11.2 
Contains Device Pack 1.0.7.0 

New 
New 
AIR-16085 Automatic upgrade feature for Symphony Client 

Now includes Symphony Client upgrades in addition to Device Packs 
See also KB Article: How to change download scheduling and speed for Device 
Pack and Symphony Client updates 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10179
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10179
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Improvements 
Improvements 
AIR-19232 Overload protection message now indicates which server has high CPU load 
AIR-19253 Improved performance from decreased load on database 
AIR-19254 Increased performance from reducing CPU load 

Fixed 
Fixed 
AIR-12630 Can use keyboard to select Windows Authentication check box in Symphony 

Server Connection dialog box. 

 
AIR-15451 Setup Wizard Status Setup dialog box no longer showing erroneous “Failed to 

notify the following servers” message 
AIR-18475 Phoenix input alarm rule action successfully moves PTZ camera to preset location 
AIR-18490 SNMP walk command successful when setting SNMP Retries to 2. 

Instruction added to Symphony 6.12 Administration guide:  
SNMP using UDP, set SNMP Retries to 2.  (Using iReasoning MIB browser, for 
example, Tools>Options>General tab, SNMP Retries=2 field.) 

AIR-18746 Manage Services and Devices access rights correctly enforced 
AIR-18747 Failover on multi-server farm: showing correct number of cameras on servers and 

correct number of redundant servers 
AIR-18750 
and  
AIR-18751 

Importing large number of cameras successful 

AIR-18763 Client on one machine accurately updated when changes made to same client 
running on another machine 

AIR-18768 
and  
AIR-19018 

Successfully export .aira and .avi from a standalone client. Video export from 
Client working correctly when server and client in different time zones 

AIR-18837 Camera ID/code visible in video when using Direct Connect 
AIR-18841 Failover successful after power outage and hardware issues 
AIR-18844 Failover to correct servers after power and database outage 

https://www.aimetis.com/Library/Downloads/Aimetis_Symphony_6.12_Administration_Guide.pdf
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Fixed 
AIR-18860 Moving numerous cameras to another server not issuing erroneous database 

connection loss messages 
AIR-18861 New Carousel dialog box opens correctly 
AIR-18863 Camera Tree displayed correctly after ActiveX Plugin installed on machine with 

Symphony Web Client 
AIR-18866 View Logins dialog box loads successfully with over 500 concurrent users logged 

in 
AIR-18867 Symphony Client runs successfully when opening more than 1000 cameras in  

Activity For Cameras dialog box 
AIR-18868 
and  
AIR-19197 

Ban Video feature in Web Client correctly denying specific user access to camera  

AIR-18874 Web Client on HTTPS: When redirecting requests, Symphony preserves HTTPS 
protocol and HTTPS port. 
Important: All servers in a multi-server farm must have SSL certificates installed. 
If not, then you will receive an “Internet Explorer cannot display the webpage” 
error. See also: How to Configure Symphony Web Servers for SSL (Windows 8) 

AIR-18877 Selecting an alarm in the Basic or Advanced Alarm log correctly shows the 
matching image (JPEG) in the panel (camera view)  

AIR-18880 Delete All Searches, View Search Details, and Search speed improved and Delete 
All Searches issue with non-responsive Symphony Client resolved  

AIR-18883 Correct status for PTZ lock/unlock displayed in PTZ Lock Properties dialog box 
AIR-18884 Hikvision cameras working correctly in Direct Connect mode 
AIR-18885 Muted audio on camera correctly remains muted upon Camera Tree refresh 
AIR-18887 View Detail Events on busy server farm loading correctly 
AIR-18895 User can now unlock PTZ using PTZ Lock Properties dialog box options after 

initiating lock with PTZ Controls (lock icon) or red arrow method (right-click and 
mouse move) 

AIR-18996 ExportDIORulesToCSV.exe too is successfully exporting rules to .csv files 
AIR-18902 Time decorations readable when using H264 480x360 on Mobile Android devices 
AIR-18904 Phoenix Device selected and saved with various Inputs and Outputs no longer 

generating Exception errors in Log Files 
AIR-18916 CPU overload protection working correctly 
AIR-19920 Supervisor mode: permissions enforced correctly for editing supervisor account 
AIR-18951 Client correctly will NOT update with changes from other users (on other clients) 

while Server Configuration or Camera Tree open 
AIR-18995 Memory use decreased 
AIR-18958 Moving camera to another server successful and correctly updates server field of 

camera 
AIR-18953 Axis audio settings pushed and received properly 
AIR-18963 Database disconnection issue resolved. See also How to reduce deadlocks and 

improve SQL server throughput and performance 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10218
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10221
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10221
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Fixed 
AIR-19022 Access Denied message correctly displayed for user with limited permissions 

viewing camera using Direct Mode 
AIR-19023 German interface: space expanded for proper text display  
AIR-19026 PTZ Locked label on video correctly disappears after lock time expired 
AIR-19030 Historical JPEGs (images) correctly showing Decorations 
AIR-19033 Correct number of Users Viewing Camera tabulated in client using Direct Connect 

during minimized and restored Multiviews 
AIR-19073 Videowall Manager successfully handling exceptions 
AIR-19074 No adverse effect with changes in Camera View Settings>Activity tab for 

Videowall  
AIR-19106 Symphony correctly allows editing and saving active ports on I/O devices 
AIR-19122 User can successfully view live video in direct mode from camera on down server 
AIR-19129  PTZ Locked label correctly disappears when camera unlocked 
AIR-19213 Videowall correctly generates error messages when user tries to change a panel 

with an incorrect panel name or when the Client is not running 
AIR-19214 Symphony correctly saves modified stream values for Pre and Post Event 
AIR-19215 Stream successfully deleted for a camera 
AIR-19246 View>Activity for Cameras time reference starts at midnight when dialog box 

first open or for a selected date 
AIR-19256 Tracker synchronization process working correctly 
AIR-19298 License message correctly displayed in language setting of Symphony and OS 
AIR-19301 Videowall functioning correctly with Add Camera View feature 
AIR-19425 Exceptions in Rule Schedule saved correctly 
AIR-19490 Symphony functioning correctly when registering new videowall client in 

videowall designer 
AIR-19505 Smooth video playback from Panasonic cameras with lower CPU usage 

Known Issues 
Known Issue 
AIR-19484 Client-only installer does not install .NET Framework 3.5 on Windows 8 

Workaround: Install .NET Framework 3.5. See http://www.microsoft.com/en-
ca/download/details.aspx?id=21 

AIR-19511 Installation fails with exit code 1603 on Windows 2003 r2 x32 
See solution: https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10240  

 

http://www.microsoft.com/en-ca/download/details.aspx?id=21
http://www.microsoft.com/en-ca/download/details.aspx?id=21
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10240
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Release 6.11.1.1  

Fixed 
Fixed 
AIR-18325 Configuration backup process successful on large scale server farms 
AIR-18345 Panel settings (right-click on panel and select Settings) rendered correctly 
AIR-18612 InfoService correctly starts if database down 
AIR-18843 Failover working correctly 

 

Release 6.11.1 
Contains DevicePack 1.0.5.0 

New 
New 
AIR-17466 ADD-ON Feature only 

Aimetis Symphony alarms can be raised in response to intercom calls initiated 
from devices within a Jacques 650 Intercom system. 
This is an add-on feature only.  

 
AIR-17688  
 

New Shadow Removal option in Environment tab of Multi-layer Hybrid 
background of VE180: reduces the effect of shadows, while preserving the 
foreground objects.  
Previously only available as parameter in XML. See KB article for 6.11.0 release:  
ShadowRemoval parameter for VE180 analytic engine 
 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10186
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10186
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Improvements 
Improvements 
AIR-16034 SMTP Port Configuration for emailing. You can define which port to use for the 

SMTP server. Note that you must select the SSL check box to work with Google 
Gmail. 
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Improvements 
AIR-16128 Reports: 

• The Generate Image option is valid and displayed only for Heat Map 
reports. 

• The Include Summary Information option is valid and displayed only for 
Object Counts Across a Line reports. 

 

 
AIR-16596 Symphony 6.11.1 installation now supported on Windows 8 and Windows 2012. 

Previously: https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10204  

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10204
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Improvements 
AIR-17637 Customers can now customize report filenames 

By default, the filename is configured as:  
Report Name_Year_Month_Day_Minute_Seconds_Milliseconds 

 
AIR-18056 Heat Map zones: user can now move both the horizontal and vertical edges on an 

angle 
AIR-18355  Onscreen tracking path output for PT091 removed. Less distracting to user 

viewing video from moving camera. 
AIR-18375 Extensive improvements to Videowall with significant reduction in CPU load 
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Improvements 
AIR-18507 New option to restrict users to login in only once per server farm 

Server Configuration>General Settings, Limit concurrent connections option 
changed to Do not allow more than one concurrent connection per user 
 
Previously: 

 
AIR-18554 New SDK command line program TimelineGetter.exe 

 
AIR-18569 Batch file for updating database for resolving user permission issues OR 

"rerunning setup wizard may solve this" message 
AIR-18611 Improved log retrieval for large server farms 
AIR-18621 New server setting to disable/enable Videowall snapshot auto update 

See KB article: How to enable the automatic snapshot update in Videowall 
Manager window in Symphony 6.11.1 

AIR-18632 Background model improvement for images from thermal cameras. 
It gives equal importance to intensity differences across the whole range of 
possible values. 
New Thermal option in Environment tab of VE180 analytic for Multi-layer Hybrid 
background model. 

AIR-18753 3rd party systems can be connected o Symphony Server via the Symphony SDK 
and play video from any camera that Symphony supports inside their client 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10206
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10206
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10208
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10208
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Fixed 
Fixed 
AIR-12964 Managing rules with camera selections as sub-events working correctly 
AIR-15030 Activity column in Object Statistics Report now displayed to 4 decimal places 
AIR-16033 Reports: When configured for 24 hour clock setting, Reports correctly display 24 

hour times 
AIR-17217 Reports – Sensitivity tab: Error no longer created when user mistakenly deletes 

numeric value in minute, seconds, or milliseconds fields for Dwell Threshold 
AIR-18095 Alarms displayed correctly when live video disabled 
AIR-18343 Videowall with direct connect correctly showing video and blank panel correctly 

showing blank after switch 
AIR-18491 Symphony enables health monitoring correctly 
AIR-18532 PTZ camera tours working correctly when using schedules and auto-tracking 
AIR-18537 AI Authentication service starts after upgrading to Symphony 6.11.1 

Previously: AI Authentication service will not start after upgrading to Symphony 
6.11.0.x 

AIR-18541 Double-clicking on device in Quick Find correctly displays video from camera  
AIR-18543 Vivotek FE817X (fisheye) cameras dewarp image correctly for ground and ceiling 

mount mode, functioning like PTZ 
AIR-18567 WCF-NonHTTP-Activation is installed during upgrade process, resolving AI 

Authentication service issue  
AIR-18593 Deleting layout and/or Multiview layout working properly in conjunction with 

interface   
AIR018626 DIO rule to alarm on all cameras for systems with over 1000 cameras no longer 

overloading CPU and causing tracker to run out of memory 
AIR-18641 Live video successfully displayed on iOS devices 
AIR-18650 LPR upgrade now automatically manages version compatibility between Server 

and ALPR during installation 
 

  

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10205
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10205
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Release 6.11.0.1 
Includes Device Pack 1.0.4 

Fixed 
Fixed 
AIR-17270 View Detailed Events dialog box now shows Key=users for Supervisor Logon with 

two users 

 
AIR-18570 Camera connection memory over-allocation issue resolved 
AIR-13284 Value in PTZ Lock minutes automatically correct when user enters invalid number 

of minutes in PTZ Lock dialog box 

 
AIR-13287 Deleted layouts correctly removed from Videowall manager 
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Release 6.11  

New 
New 
AIR-4869 New user privileges for hearing audio from stream 

 
AIR-6924 Camera load balancing between servers (requires Professional license) 
AIR-11376 Videowall manager: user can save and restore layout, minimum window size is 

now smaller, and user can drag and drop cameras to videowall from Maps 
AIR-11705 Saving video clip directly to server/NAS implemented as part of Video export 

feature in Symphony 6.8 



 

24 
Copyright © 2020 Aimetis Corp. 

New 
AIR-12733 
AIR-17312 

Symphony now supports two-way audio (for Axis, Sony, and Vivotek cameras 
only) 

 
 

 
 

 
 

 
See also AIR-4869 
Works with direct connect mode as well 
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New 
AIR-12959 Symphony now supports Bosch Dinion camera I/O on Maps and in Camera Tree 
AIR-15234 Administrators can view which users are viewing a camera 
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New 
AIR-16617 New option to restrict users to login in only once per server farm 

Server Configuration>General Settings, Limit concurrent connections option 

 
 
When a Symphony Client (or Web Client) session is terminated by an 
administrator, the client's farm connection changes to "Unauthorized" and a 
Logon dialog box is displayed. 
The user can log back in by providing valid credentials. 

 
Known Issue: 
In this BETA version, this feature does not work with Symphony Active 
Directory Integration/Single Sign-On. As such, this feature of One Login Per User 
is not properly enforced when users login to Symphony using Windows 
Authentication. The Current Logins feature fails to reliably detect current logins 
when made through Windows Authentication. 

AIR-16629 Symphony now supports Hikvision DIO on Maps 
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New 
AIR-17029 New interface for VE180 Video Analytic 

 
3D Accurate People Tracking Advanced Tab 
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New 
AIR-17029 
(continued) 

2D Fast Object Tracking Advanced tab 
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New 
AIR-17030 BETA: VE180 video analytic now supports a Face tracking mode 

 
 

 
 

 
AIR-17107 Multiple streaming improvement reduces server, client, mobile bridge server, 

and video CPU usage and bandwidth 
AIR-17237 Symphony now supports Hikvision DS-2CD7254FWD-EIZ cameras 
AIR-17349 
AIR-6924 

CPU overload protection setting 
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New 

 
AIR-17504 Symphony now supports JCI cameras 
AIR-17688 New background model that reduces the effect of shadows 

See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10186  
AIR-18046 Symphony supports AES256 for Single Sign On within a single domain. See also 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198 
AIR-18062 Added support for Johnson Controls DVN5000 NVRs 

Improvements 
Improvements 
AIR-12325 Device Pack installation and Client Updates 

how to: https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10165 
error messages: 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10162 
 

 
 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10186
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10165
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10162
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Improvements 

 
AIR-13742 User can drag and drop results from Quick Find search into any camera panel 

 
AIR-14046 Administrator can see which user has PTZ camera locked 
AIR-15235 Symphony SDK enhanced. SDK user can view a list of panels and videowalls that a 

particular user has permission to change 
AIR-15262 ImportDeviceGroups utility now provides user with a confirmation dialog box if 

errors found in .csv file  
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Improvements 

 
 

 
 

AIR-15303 Symphony supports I/O from Samsung devices, including I/O on Map and Camera 
Tree 

AIR-15349 New Override label beside camera indicates that Record Video in the camera 
setting was changed by right-clicking in the Camera Tree to Stop Recording. 
 The Override label reminds the user to right-click and Resume Record mode 
when necessary. 
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Improvements 

 
 

AIR-15995 Symphony now supports multicast on HikVision cameras  
DS-2CD883F-E 
DS-2CD853F-E 
DS-2CD854FWD-E(W) 
DS-2CD855F-E 
DS-2CD864FWD-E 
DS-2CD7283F-EZ 
DS-2CD7254FWD-EZ 
DS2CD7264FWD-EZ 
DS-2CD754FWD-EZ 
DS-2CD753F-EZ 
DS-2CD754F-EZ 
DS2CD783F-EZ 
DS-2CD764FWD-EZ 
DS-2DF1-57A 
DS-2DF1-570A 
DS-2DF1-583 
DS-2DF1-5803 
DS-2DF1-5833 
DS-2CD7153-E 
DS-2CD7164-E 
DS-2CD7264  
DS-2CD7254 
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Improvements 
AIR-15997 Schedule: You can now schedule rules, guard tour schedules, and camera 

recording schedules to per minute settings.

 
 

AIR-16205 New sensitivity parameter for VE180 analytic engine 
High sensitivity level setting helpful in cases where a person's clothing is merged 
with the background and low sensitivity level setting helpful in cases with high 
levels of shadows or background movement. 
Note: This new ForegroundAppearanceSensitivity parameter is not the VE180 
interface. Accessed only by editing the configuration XML. 
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10176 
 

AIR-16423 Upgrade installer now verifies installation types: Symphony Server, Symphony 
Client, and Symphony Player.  
For example, Symphony Server must be upgraded with the server installation, 
Symphony Client with the client installation, and Symphony Player with the player 
install. If wrong installation detected, the user is prompted with a message and 
upgrade stops after the user clicks OK. The message box informs the user about 
the product and type of installation currently running, and instructs the user to 
run the correct upgrade.  

AIR-16884 Symphony allows auto tracking on most Bosch Autodome cameras 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10176
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Improvements 
AIR-16951 Symphony Rule Wizard allows you to alarm on loitering vehicles 

 
AIR-17040 Live Video runs smoothly even when writing to slow devices such as USB stick, 

NAS, or a busy disk 
AIR-17044 Symphony now supports Samsung SNB-5001/7001 and SNP-6200(H) cameras. 

See http://www.aimetis.com/Support/supported-video-devices.aspx  
AIR-17059 Increased accuracy of VE180 people counting 
AIR-17072 Maximum threshold in VE180 Multi-Layer Hybrid background model can now 

accept values up to 500 seconds. 
Select VE180 ->Environment -> Multi-Layer Hybrid, Adaptation  

 
AIR-17243 Dwell time estimation improved in VE180 analytic engine 
AIR-17409 Symphony now supports Pelco D5118 TCP cameras 
AIR-17437 When adding Multiview window to monitor with console, Multiview correctly 

appears on top of console in Videowall Manager 

http://www.aimetis.com/Support/supported-video-devices.aspx
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Improvements 
AIR-17458 Axis P5534-E camera pre-calibrated for auto-tracking 
AIR-17524 LPR – License Plate Recognition white/black list reload.  See Aimetis License Plate 

Recognition: How to configure Symphony to allow a 3rd party system to update 
the license plate list  

AIR-17539 Axis P5522 camera and Axis P5500 series pre-calibrated for auto-tracking 
AIR-17545 Symphony logs warning for PTZ auto-tracking if camera movement responses 

delayed more than 1 second 
AIR-17593 
AIR-17285 

Improved performance in PT091 video analytic 

AIR-17596 Symphony restore configuration/data process warns user in case data is older or 
newer than the user’s current version of the software 

AIR-17385 PTZ mode available immediately when adding Oncam cameras in 6.11. User does 
NOT need to adjust the acc.ini file 
Notes:  
You must enable panoramic technology for the Oncam camera: 

• In the Server Configuration dialog box, click the Video tab. Select the 
Enable panoramic technology check box.  From the drop-down lists, 
select the Oncam camera and a Position (wall, ceiling, ground). 

 
You can select panoramic modes from the context menu of the panel for the 
camera. 
In Fisheye View mode dewarping is turned Off; in other modes it is On. 

• Right-click on the panel displaying video (live or historical) from the 
Oncam camera. Select Dewarp. All options are displayed. 

 
See also: https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10164  

AIR-17691 Symphony receiving video from Axis cameras correctly after Axis Media Parser 
upgrade 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10160
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10160
https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10160
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10164
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Improvements 
AIR-17800 Windows Desktop Experience now automatically enabled on server platforms for 

Windows 2008 R2 and later during Symphony installation 
AIR-18046 Symphony supports AES256 for Single Sign On within a single domain. See also 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198 
AIR-18048 Logs: sccp.txt log file (cpu and memory stats) now also contains Windows and 

Symphony processes, total memory CPU consumed by Windows and Symphony 
processes, and column headings for clarity 

AIR-18049 CPU load reduced for Symphony using Messoa cameras 
AIR-18055 Memory and Logging tabs functionality in Symphony Client Settings merged into 

new Advanced tab. New option for enabling/disabling message to user in the 
event of a Symphony Client crash 

 
 

  

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10198
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Fixed 
Fixed 
AIR-7415 Symphony now supports Pelco Endura Spectra III EVS cameras 
AIR-8847 Heat Map Report: Tabular data now sorted by date and then time columns 

(ascending). This applies to both exported tables and exported scheduled heat 
map reports 

AIR-9457 Camera Tree updated correctly on Symphony client after deleting many groups 
from Camera Tree  

AIR-9642, 
AIR-14132, 
AIR-14640 

Cameras in Camera Tree show correct status of On when recording and Off when 
not recording 

AIR-9840 Carousel window description correctly displayed as Carousel [Carousel Name] - 
Server Name - Camera ID#) Camera name 

AIR-10857 When clicking on alarm in the Alarm Log, the Map panel correctly displays the 
map associated with the camera alarm 

AIR-11079  
 

Numerous fixes to display and layout of text in German language interface 
(AIR-11115, AIR-11116, AIR-11119, AIR-11078, AIR-11081, AIR-11088, AIR-
11106, AIR-11108, AIR-11133, AIR-11122, AIR-11124, AIR-11125, AIR-11126, 
AIR-11133, AIR-11134, AIR-11135, AIR-11137,  AIR-12928, AIR-12942, AIR-
12945, AIR-12921, AIR-12946, AIR-13715, AIR-18251, AIR-11563) 

AIR-11698 Converting .aira files to MPG4 successful and play smoothing in Windows Media 
Player 

AIR-11720 Hikvision camera resolutions displayed properly 
AIR-12016 Videowall with video from Bosch Dinion cameras refreshes images correctly with 

no anomalies 
AIR-12229 Device import maintains correct licenses in Symphony 
AIR-12451 Floating Multiview loads correctly after saving 
AIR-12458 PTZInfo data handled correctly in import/export of .csv device list  
AIR-13049 User can load 1000+ maps without encountering unhandled exception errors  
AIR-13051 Maps - sorted alphabetically and “New Map” name is displayed with original 

filename.  
• When adding a new map, the Edit Maps dialog box focuses on the new 

map in the list.  
• When searching for a map in the main view search field of Maps, partial 

matches are displayed based on the text entered in the search field. 
AIR-13597 SNMP Enabled setting changes in Server Configuration will take effect within 5 

minutes on each server 
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Fixed 
AIR-14080, 
AIR-17141,  
AIR-17206, 
AIR-17397 

New columns added to CSV import/export options for device list. 
Support RTSP streams in CSV camera import/export (Improvement) 
 
Record Schedule ID  
Record Schedule ID Stream2  
Record Schedule ID Stream3  
Record Schedule ID Stream4 
Rotate Degrees 
Resolution Stream2, 3, 4  
RecordFPS Stream2, 3, 4  
VideoFormat Stream2, 3, 4  
RecordVideo Stream2, 3, 4  
VideoQuality Stream2, 3, 4  
KeyframeInterval Stream2, 3, 4  
PreEvent Stream2, 3, 4  
PostEvent Stream2, 3, 4 
Audio Output 
See the entire list: 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10123  
 

AIR-14082 Live video displayed correctly in Symphony Web Client when live camera moved 
or swapped to another server 

AIR-14094 Client connections remain stable during database outage and when reestablishing 
connection 

AIR-14367 Improved integration of Basler BIP2 series devices  
AIR-14453 SNMP is recording correct duration for web client login 
AIR-14505 Access successful after registering/unregistering videowall client  
AIR-14571 Editable Pre Event and Post Event fields correctly displayed when Record video 

in Schedule or Schedule and Motion Detected by PC modes  
AIR-14606 .aira files converted successfully with Aira2Mp4 
AIR-15081 Correct context menu options displayed for user with denied access to Manage 

Recording for all devices in Camera Tree for individual cameras and camera 
groups 

AIR-15229 Multiple panels set to switch on alarm functioning correctly: only one panel 
switches to the alarm camera. If multiple (different) alarms in succession, a 
different panel is switched (if within 8 seconds) 

AIR-15232 New SNMP traps supported by Symphony:  Health monitor fault detected,  Health 
monitor corrective action 

AIR-15254 Bosch Autodome 700 auto-detection, HD Live video, Record and Playback 
working correctly 

AIR-15270 Bosch Autodome 800 auto-detection, HD Live video, Record and Playback 
working correctly 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10123
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Fixed 
AIR-15292 Aira2Mpeg speed parameter usage clarified and compared with Aira2Mp4 

 
For Air2Mpeg [speed] is: 2.0 -> 50% speed, 1.0 --> normal, 0.5 --> 2x video speed. 
 
For Aira2Mp4 [speed] is: 2.0 -> 2x video speed, 1.0 --> normal, 0.5 --> 50% speed. 
 
See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10178 
 

AIR-15302 6.7 or later Client connects successfully to 6.6.x or earlier Server 
AIR-15429 
AIR-17039 

On-camera storage: Video downloads correctly for short interruptions 
General improvements 

AIR-15438 HTTPS encrypted connection changes for Web Client. See KB article 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10169 

AIR-15495 New Aira2Mp4  tool does not require any codecs to be registered on the user's 
machine. Use instead of Aira2Mpeg when converting AIRA files. 

AIR-15561 Correct time stamp and Alarm Log details time data for the alarms before and 
after the DST transition 

AIR-15566 Symphony Export Video feature handles DST (from summer to winter time 
change) 

AIR-15575 DIO working correctly if server at 5000 and 5001  

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10178
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10169
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Fixed 
AIR-15604 User can select narrower time frame for Event Data in Help>View Detailed 

Events dialog box. 
 

 
 
If threshold exceeded, user is warned with message and option to download 
more. 

 
User can also set threshold for event data in the Manual Configuration Editor. 
See KB https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10177 
 

AIR-15787 DIO reliable on Maps when using a high number of maps. For example, user can 
add DIO input and outputs to Symphony server that contains 1000 maps 

AIR-15817 Carousel can be properly docked in main console 
AIR-15959 PTZ tour locations working correctly in Multiview (Camera view) 
AIR-15971 User with Export Video and Convert searches to other formats permission can  

correctly convert search result in MPGEG format 
AIR-15983 Console layout rendered correctly when docking two carousels and opening 

Application Log 
AIR-15986 Carousel displayed in the full screen correctly  
AIR-16031 Workaround for Timeline fills entire console   

Changing regional settings in Windows Control Panel to German may cause 
Timeline to fill entire console. Issue cannot be reproduced, but if encountered, 
you must manually load a layout and the Timeline will be the correct size 

AIR-16073 Samsung SNP-3371 and SNP-3120 PTZ accurately controlled with mouse 
AIR-16075 Taskbar correctly appearing in background 
AIR-16124 Custom browser page displayed on Client start-up 
AIR-16145 User Configuration correctly accessible by Admin user after security profile 

switches 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10177
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Fixed 
AIR-16211 Camera configuration: DetectionXML set and updated correctly, and retains valid 

data when modifying existing camera with invalid IP 
AIR-16372 Resolved floating Multiview issue of white gap appearing between top panels and 

window  
AIR-16442 Highlighted zoom functioning as designed 
AIR-16464 Person reference icons in VE180 video analytic camera setup view formed 

correctly when Distance field changed 
AIR-16500 Phoenix alarms received even when database down 
AIR-16522 Toolbar (navigation, timeline, decoration buttons) enabled if Client interface 

locked 
AIR-16537 VE180 with dwell time is now white text on black background 
AIR-16546 For Admin group, for all security profiles, permission added as Allow 
AIR-16548 Window size of docked Multiview (camera view) retained when Client locked 
AIR-16624 Pelco 4001 encoder integration resolved 
AIR-16636 Symphony working correctly with 2MP mode in Samsung SND- and SNV-7080 

cameras 
AIR-16653 Docked Multiview panels scaling correctly when loading Multiview 
AIR-16666 Symphony no longer supports Genetec Omnicast 
AIR-16716 Bosch Autodome 800 pans, tilts, zooms correctly in Symphony 
AIR-16819 Full alarm information included in alarm email in Chinese version of Symphony 
AIR-16823 Samsung cameras that support streaming over UDP displaying correct video 

streams 
AIR-16892 Clearer message provided to users of ALPR that they cannot delete detected 

license plate entries detected within the last 100 days – as designed. 
Also see KB article:   Error Message: One or more plates could not be deleted 

AIR-16894 Symphony detecting Axis P334X cameras correctly as fixed 
AIR-16963  
AIR-17043 

Heat Map Report successfully created on non-English operating systems 

AIR-16964 Reports: Line graph correctly shows time intervals when only one camera 
selected 

AIR-17031 Maps with many camera icons load rapidly 
AIR-17062 Symphony supports audio input on Vivotek cameras 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10195
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Fixed 
AIR-17160 Email notification option in Notifications screen of Server Configuration dialog 

box changed for clarity to Video or Search deleted from “Footage/video deleted” 

 
AIR-17162 Multi-view (Camera View) renders correctly when changing to full screen 
AIR-17165 Decorations line up correctly on high and low resolutions 
AIR-17218 Devices do not move to different server when database services stopped or 

database rebooted 
AIR-17234 Improved accuracy of people counting 
AIR-17241 In PDF format, Heat Map Report all columns correctly appear on one page 
AIR-17289 Symphony displays correct map when camera switched 
AIR-17290 Can import a CSV list that was exported from a 6.10 server 
AIR-17302 PTZ Camera triggered to record on motion correct records and stops 
AIR-17335 Alarm marking message "For performance reasons, you can only mark 50 alarms 

at a time" is correctly displayed only once when more than 50 alarms are selected 
for marking as real. 

AIR-17363 InfoService User Account correctly updated during upgrade 
AIR-17521 Map icons for camera, link, I/O device, or rule can be deleted successfully in Edit 

mode 
AIR-17548 Symphony Player able to play a video (with known missing frames) in its entirety 
AIR-17557 Default tour name in Chinese for Chinese version working correctly 
AIR-17558 Distributed heat map reports sent successfully 
AIR-17588 Aira2Mpeg.exe now exporting faster video clips 
AIR-17618 Axis 232D and 211A PTZ camera no longer loses connection when alarm with 

Auto-tracking triggered 
AIR-17656 Symphony now supports auto-tracking for Axis P5512 camera 
AIR-17744 FTP tab in Rule Wizard – Resize the transferred file setting reducing alarm 

images correctly 
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Fixed 
AIR-17766 When selecting 2 streams with the same resolution, Highest resolution option 

uses the stream with highest FPS and Lowest resolution uses stream with lowest 
FPS 

AIR-17773 User can easily create and delete fence line for VE150 in Rule Wizard 
AIR-17788 PTZ control no longer generating database errors in log 
AIR-17825 Resolution issues in some cameras, including Eneo PX Thermal cameras, have 

been corrected with user adjustments necessary in Client and Server. For 
instructions, see KB article: 
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10172  

AIR-17833 Live and historical video streams correct for ACTi D11 and E11 cameras 
AIR-17867 Handle leak on Panasonic camera resolved 
AIR-17869 Zoom speed when using Joystick for PTZ camera reaching correct maximum value 
AIR-17881 User can set language for SMTP Messages 

See https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10185 
AIR-17887 Setting Default max storage days to 0 in Server Configuration, Storage dialog has 

no impact on Scheduler 
AIR-17892 
AIR-18130 

Report emailing working reliably 
 

AIR-17917 Continuous Alarm option functions as designed 
AIR-17919 All users (including non-admin users) can view/modify their user information in 

the Server>User Configuration dialog box. 
Farm registration is automatically updated if credentials are changed through the 
User Configuration dialog box on the local machine 

AIR-17936 OPC alarms working correctly 
AIR-18004 Messoa camera correctly displays video when database change camera settings 

option disabled 
AIR-18038 PTZ control through interface and joystick functioning correctly for Panasonic PTZ 

cameras 
AIR-18088 Socket handle leak fixed and logging improved 
AIR-18102 DDK cameras correctly receiving live video 
AIR-18126 Failover working correctly and stable database connection 
AIR-18128 Report columns correctly hidden when running a scheduled report 

Note: If user wants to include summary information with a report (Distribution 
tab), and user has hidden one of the columns used as a summary key, then the 
summary information for that column will not be included in the report. Applies 
to emailed and file saved reports as used by the distribution option. 

AIR-18129 Report storage location correctly updated if user modifies storage path location 
AIR-18131 Heat Map report displays zone labels correctly 
AIR-18135 Playback functioning correctly on Axis cameras recording 2 streams 
AIR-18136 Axis camera functions correctly when change frame rate on alarm option used 
AIR-18137 Reports list refreshed before batch run of scheduled reports ensuring that 

deleted reports not included 

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10172
https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10185
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Fixed 
AIR-18141 
AIR-18156 

ALPR: Issue causing error “Cannot start; required Dlls are missing” resolved 

AIR-18146 Axis P3344 cameras detected correctly as Fixed 
AIR-18164 Scale correctly displayed in Heat Map image 
AIR-18196 Alarm Picture correctly attached to emails for alarms triggered on motion 
AIR-18260 Symphony Search feature working correctly. See error message information in  

Error Message: Search is unable to complete knowledge base article 
AIR-18271 Visual C++ errors averted as Vivotek camera loads correct device dlls 
AIR-18283 Symphony protected from SQL injection and SetDocument path override 
AIR-18362 
 

VMD or I/O event raising alarms correctly 

AIR-18431 Audio from Axis cameras received in Symphony Client 

  

https://www.aimetis.com/Xnet/KB/KBArticleDetails.aspx?ID=10190
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Known Issues 
Sound 
AIR-16867 Release 6.9.5, 

6.10 
Playing audio files via Rules does not work when using Server 2008 
R2/Windows 7/Windows Vista 
 
Workaround: 

1. Download “psexec” online 
 (http://technet.microsoft.com/en-us/sysinternals/bb897553.aspx) 

2. Setup AI Scheduler service to login as a user that has 
previously logged into the server interactively. 

3. Setup the computer to  automatically log in on bootup as 
the same user that is logging in AI Scheduler. 

4. Create a playsound.bat batch file (all one line): 
psexec.exe -i 1 
f:\branches\trunk3\aira\_bin\schedulerplayer.exe play 1 0 
c:\windows\media\chimes.wav 
 
psexec.exe –i <session to run program in> <path to 
schedulerplayer.exe> play <number of times to play> <delay> 
<path to audio file to play> 

5. The key “–i 1” must specify the interactive session number 
for the process to run in.   

a. To get a session number, run procexp.exe and turn 
on the session# column. 

b. Look at the session number for a process running 
as the logged in user. This is probably always 1 on a 
Windows installation with a logged in session; 
therefore “-i 1” should always work. 

6. Create a rule action similar to the following: 

 

http://technet.microsoft.com/en-us/sysinternals/bb897553.aspx
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Sound 
Cardax Integration 
AIR-16857 Release 6.10 User must repair OPC Bridge Configuration Version 6 from Cardax after 

Symphony upgrade 
Installing OPC Bridge Component 6.1.0.5 and the OPC Core Components 
Redistributable software pieces are required for Cardax Access Control. 
The OPC Bridge Component stops working after a Symphony server 
upgrade. 
Workaround: 
If you have OPC Bridge Configuration Version 6 from Cardax installed 
you must repair it after upgrading Symphony by re-running the OPC 
Bridge Configuration installer. 

 

Camera 
AIR-12315 
Renumbered 
as PACK-254 

Release 6.5 
 

Support latest Mobotix Firmware for VMD of camera 
 
VMD from Mobotix cameras is working only on devices running Fw. 
3.4.09 (from 2008). With the Fw. 3.5 and 4.x (running on all new 
models like M24, D24, Q24) it is not possible to use this 
functionality. 

AIR-12896 
 

Release 6.6 
 

When adding Axis 241Q, only the first channel has default codec 
set Camera 
When adding Axis 241Q and other multi- channel video servers, such 
as Hikvision 6104), and clicking the Connect to Camera button, only 
the first channel has the default codec settings. All others channels 
have a blank codec. 
Will not fix. 

AIR-15613 Release 6.9 Multi-lens cameras require one license 
If you select a multi-lens camera, multiple licenses will be required. 
You must contact Sales to be given the difference of licenses, for 
free. 
This problem is typically only with Arecont cameras. 

 

Interface 
AIR-12409 
Renumbered 
as PACK-175 

Release 6.5 Vivotek FD8361 crops image in stream 2 and displays stream 1 
when navigating away from camera 
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LPR 
AIR-
17540 

Release 
6.10.1 

When LPR installer prompts user with message regarding gxsd.dat file, 
user should select No. 
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